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Introduction

Introduction
Learn-by-Doing: Microsoft Office Specialist Word 2016

As the name implies, the Learn-by-Doing Series gets students learning Microsoft 
Office 2016 by using its applications to do what is needed to communicate and share 
information in the real world of work and life. This book uses step-by-step instructions 
and illustrative screenshots to introduce and reinforce the skills needed to pass the 
Microsoft Office Specialist Word 2016 Certification Exam. 

Designed for today’s interactive, visual learner, this text consists of graphical hands-on 
lessons that get students instantly engaged in applying Microsoft Word 2016 skills. 
Students will learn how to format text and paragraphs, work with tables, and design 
sophisticated multi-page documents as they explore the powerful features and 
interface of Word 2016. 

Microsoft Office Specialist (MOS) Certification
Microsoft Office Specialist (MOS) is an industry-leading certification designed to 
assess mastery of Microsoft Office applications. Candidates are evaluated on their 
ability to apply their knowledge of important Microsoft Office features in a project-
based environment. Certified Microsoft Office Specialists demonstrate internationally-
recognized skills that can be leveraged for future success in both the classroom and the 
workplace. To support students seeking MOS certification, this text provides detailed 
instruction in all of the skills assessed on the MOS Word 2016 Certification Exam.

Benefits of Using This Textbook
Learn-by-Doing: Microsoft Office Specialist Word 2016 is designed to be used by 
students enrolled in a word processing computer applications course, and by learners 
looking to expand their knowledge of Microsoft Word 2016 for MOS certification. 
Students should have a basic familiarity with working on a computer. Microsoft Word 
skills and features are presented in order, ranging from basic to intermediate. The 
lessons in this book reinforce and build upon knowledge as it is acquired; therefore, 
lessons should be completed in the order presented.

Throughout these lessons, you will also gain hands-on experience with all the skills 
assessed on the MOS Word 2016 Certification Exam. MOS certification can help boost 
confidence in your ability to use the key features of Word 2016 you may encounter in  
the workplace and beyond. MOS certification can also be a valuable asset when applying  
for jobs, helping you demonstrate experience and proficiency in essential workplace 
productivity principles, including communication and collaboration.

iiiIntroduction For Evaluation Purposes Only



Styles Pane: 
Use this pane to reveal the 
Style names and a preview of 
recommended Styles for your 
document.

Style Inspector: 
Use this icon to view the text’s formatting 
based on the Style, plus any additional 
formatting applied to that Style. 

Link: 
Use this option to link text to 
another place within a document 
or to a website.

Style Sets : 
Use this drop-down menu to apply a new set of fonts and 
paragraph formats to a selection of text.

Lesson 3.9 

Tools & Terms
Review the following tools that you will learn and practice using in this lesson, as you may be required to take an 
assessment after completing this part.

Skills
�� Use the Style Inspector

 � Insert hyperlinks

 � Apply document style 
sets 

Part 3: Formatting Paragraphs & Editing Text 

Kids Who Code 
Meeting Minutes 2
Applying Hyperlinks to Text

Lesson Overview
Working with another person’s documents has its challenges. One of the 
biggest challenges is making formatting changes to a document that has 
been previously formatted. Upon first glance, it is not always easy to see 
what style someone used for text formats and, if you are trying to keep 
things consistent, this information is necessary. The Style Inspector is a 
feature that allows you to see the font style, size, color, and other formats 
to a selection of text, and it can help you seamlessly work with documents 
created by other users. The Style Inspector will confirm the changes that 
were made to text as you recall the styles you applied. Style sets allow you 
to change the look of a selection of text with preset font and paragraph 
formats that coordinate well with one another.

In this lesson, you will retrieve the previously created meeting minutes document, 
review the formatting styles that were applied, and hyperlink text to a computer 
science website.

96 Learn-by-Doing: Microsoft Office Specialist 2016

1. Launch Word 2016 and open the file named 3.8 Kids Who Code Meeting 
Minutes from your My Word Projects folder on your hard drive or network 
drive.

2. Save the file as 3.9 Kids Who Code Meeting Minutes 2 in your My Word 
Projects folder on your hard drive or network drive.

3. Select the title text of the document [Kids Who Code Meeting Minutes].

4. From the Home tab, Styles group, do the following:

a. Launch the Styles pane.

b. Click the Style Inspector icon to view the formatting styles for the selected 
text. 

c. Close the Style Inspector and Styles panes.

5. Select the text [computer science website] in the second paragraph of the 
[New business] section and do the following:

a. Right click and select Link.

b. In the Address field of the Insert Hyperlink dialog box, enter the website 
address [www.computersciencezone.org], then click OK (as shown below):

 Hint: Use CTRL + Click to test the link to the website, then close your browser.

4b.

5a.

4c.

Applying Hyperlinks to Text Lesson 3.9

4. 4a.

Instructions

97Microsoft Word • Part 3: Formatting Paragraphs & Editing Text

Lesson Overview
Explains the skills and 

concepts that will be learned 
in the lesson and provides 

context for their use in a 
particular document.

Tools & Terms
Illustrates the icons and 
menu descriptions used 

to complete the lesson. To 
demonstrate knowledge 

of this section, written 
assessments are available 

for each part.

Skills
Lists the new skills introduced in the lesson. Skills assessed in 
the MOS Word 2016 Certification Exam are identified with a red 
bullet. To provide comprehensive instruction, foundational and 
supporting skills are also identified.

Instructions & Screenshots
Instructions that are illustrated with corresponding drop-down menus and dialog 
boxes are indicated by a red  #   icon. Match each instruction with its corresponding 
screenshot as you complete the step.

  Note: Once a new skill has been presented, visual step-by-step instructions for that 
skill are no longer provided in subsequent lessons.

  Note: Office 365 is a suite of web-based applications; updates and changes happen 
regularly. At the time of going to press with this textbook, every attempt was made 
to reflect accurate screenshots and include tasks and skills that can be accomplished 
despite any updates that may occur.

Lesson Title

Introduction

Understanding the Format of This Book
This book is divided into ten parts, each containing individual lessons pertaining to the 
different ribbons in Microsoft Word 2016. Lessons in this book have been organized 
into an easy-to-read, self-guided, visual format where you encounter and practice new 
skills and learn by doing. Some lessons require access to source files to complete the 
instructions. If you do not have access to the eText of this book, lesson resources will 
be provided by your instructor.

Review the following features and components to become familiar with the structure 
of the lessons in Learn-by-Doing: Microsoft Office Specialist Word 2016.
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Student Name 
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Part 1: Written Assessment 
Covers Lessons 1.1 - 1.12 

Matching:  Write the letter of the correct match in the space below. 

_____ 11. Use this button to undo (or reverse) an action. 

_____ 12. Click this icon to quickly save a document. 

_____ 13. Click this icon to close Word. 

_____ 14. This icon is used to paste cut or copied text to another place in the document. 

_____ 15. Use this icon to see hyperlinks to relevant websites related to your selection. 

Multiple Choice:  Choose the answer that best fits each statement below.  

______ 16. If you want to move an entire paragraph on the page quickly, you should:  

a.  Retype the paragraph.  
b.  Use the "Cut" and "Paste" tools.  
c.  Use the "Undo" tool.  
d.  None of the above.  

______ 17. To Save an existing document using a new file name, you should:  

a.  Use the Undo tool.  
b.  Use the Exit tool and then rename the file.  
c.  Go to Backstage View and select Close.  
d.  Go to Backstage View and select Save As.  

True/False:  Answer True or False for each statement below. 

______ 18. The print feature in Word is located on the Home ribbon.  

______ 19. In order to Share a document with another user, you must first save the document to 
OneDrive. 

______ 20. A document may be sent as an attachment to an email. 

A. 

 

B. 

C. 

D. 

E. 

6. Select all of the text in the document and change the line spacing to single with 
no additional space before or after paragraphs.

7. From the Design tab, Document Formatting group, More drop-down menu, 
Built-In styles, select Basic (Simple) (as shown below):

8. Proofread your document for accuracy and format, then resave the file.

9. Print preview. Your document should look similar to Figure 3.9. 

10. Print or share the document if required by your instructor.

7.

Lesson 3.9 Applying Hyperlinks to Text
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Kids Who Code Meeting Minutes 
 

Call to order 
A meeting of Kids Who Code was held at Pleasant Valley High School in the student lounge on 
December 1, 20xx. The meeting was called to order at 3:30 pm. 
Attendees 
Present: Lisa Harris, Shawn Duncan, Preston Briggs, Erika Robertson, Ella May  
Members not in attendance: Velma Harrison, Hugo Craig 
Approval of minutes 
A motion to approve the minutes of the November meeting was made by Shawn and seconded 
by Erika. All in favor. 
Treasurer’s report 
Preston Briggs, Treasurer, reported that the Kids Who Code bank account currently has 
$1,873.33. Our next fundraiser is projected to raise $2,500. No new expenses are planned as of 
now. 
New business 
President Lisa Harris made a motion to begin planning for the celebration of senior club 
members. Her idea is to host a game night in their honor sometime in May. This night will be 
open to the entire student body and held in the student lounge. Donations will be accepted. A 
refreshments committee should be formed. The motion was seconded by Ella. All in favor. 
Member Ella May reported about the recent volunteer work a few of the members were 
involved in. Five club members were asked to assist elementary school teachers with 
presentations on careers in computer science. They used information from a computer science 
website. The help was very much appreciated and well received by the kids. It is very likely the 
club will be asked to present on more computer related topics during the school year. 
Announcements 
Member Erika Roberts announced that she will be moving to another school district at the end 
of this school year. Her parents have decided to downsize and sell their house in town. We wish 
Erika lots of luck at her new school where she will, no doubt, join the computer club. 
Next meeting 
Our next meeting will be held on January 14 at 3:30 pm in the student lounge. 

Figure 3.9

Lesson 3.9Applying Hyperlinks to Text
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Part 1: Performance Assessment 
Covers Lessons 1.1 - 1.12 

Read the Overview  
Being reflective about the experiences you have can enhance the impact they have on your 
personal growth. Research shows that taking time to reflect on learning can increase your 
understanding of a topic. Opportunities like an internship provide you with a chance to reflect on 
how a particular job or task relates to your future career goals. 

In this assessment, you will use some of the skills you learned in Part 1 to create a sample internship 
reflective work log. 

Instructions 
1. Using a Blank Microsoft Word 2016 document, key the text as shown on page 2.   

2. Save the document as Part 1 Assessment in your My Word Projects folder.  

3. Cut the first paragraph and paste it after the second paragraph.  

4. Copy the opening sentence in the last paragraph and paste it at the end of the last paragraph.   

5. Indent each paragraph.  

6. Proofread your document for accuracy and format, then resave the file.  

7. Email the document to your instructor if required.   

8. Print or share the document if required by your instructor. 
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Microsoft Word  
Practice Test 1 

Instructions 
1. Open the document Practice Test 1 SOURCE. 
2. Save the document as Practice Test 1 in your My Word Projects folder. 
3. Insert a Next Page section break at the top of page 2 just before the text [Aggie Hicks]. 
4. Change the line spacing on page 1 to single with no additional space before and after 

paragraphs. 

5. Change the margins on page 1 as follows: top margin 2”, bottom, left, and right margins 1”. 

6. Find all occurrences of the text [South County] and replace with [North County]. 

7. On page 2, apply the Book Title style to the subheadings [OBJECTIVE, EDUCATION, WORK 

EXPERIENCE, SPECIAL SKILLS, PROFESSIONAL AFFILIATIONS, PUBLICATIONS, HONORS, 

REFERENCES]. 

8. Proofread your document for accuracy and format, then resave the file. 

9. Print or share the document if required by your instructor. 

 

 

 

 

 

 

 

 

 

 

 

   

Introduction

Written & Performance Assessments
Your instructor may require you to complete a Written 
Assessment, which will measure your comprehension 
of the tools, terms, and features presented in each 
part. You may also be required to complete a hands-
on Performance Assessment, which will measure your 
ability to demonstrate the skills in each part. 

Microsoft Office Specialist Practice Tests
Upon completion of all the lessons in this text, your 
instructor may require you to complete a series of 
Microsoft Office Specialist Word Practice Tests to prepare 
you to achieve MOS certification in Word 2016. You will 
be provided with instructions and source documents 
to demonstrate your ability to use the Word 2016 skills 
assessed on the MOS certification exam. 

Figure
Provides the content to 
be used in the lesson. 
Figures can also be used 
as visual guidance to assist 
in producing the finished 
formatted document.

Ribbon
The primary Microsoft Word 2016 ribbon being used in the lesson is 
displayed at the top of the Instructions page. Red  #   icons illustrate the 
group being used to complete a particular skill.
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Lesson Skills

Approximate  
Completion Time 

(in hours)

Part 1:  Document Basics

1.1 Oh, the Places 
You’ll Save! 

Exploring Places to Save 
Work

 Use File Manager  Create a folder  Log in to 
OneDrive  Sync to OneDrive

.5

1.2 Getting Started Navigating Word  Create a blank document  Understand 
Backstage View  Identify ribbons, tabs, and 
groups  Change document views  Customize 
views by using zoom settings  Close Word

.75

1.3 Start of the Year 
Goals

Creating Your First 
Document

 Create a blank document  Customize views by 
using zoom settings  Save a document to a local 
hard drive or network drive  Close a document 

.75

1.4 How to Get There Saving to OneDrive  Save a document to OneDrive .5 - .75

1.5 Start of the Year 
Goals 2

Retrieving a Document  Open an existing document from your hard 
drive or network drive  Revise an existing 
document  Print all or part of a document 
 Modify print settings  Use Save As  Save 
documents in alternative file formats

.75

1.6 Believe Me Ideas Emailing a Document  Email from within Word  Email a document as 
an attachment

.75 - 1

1.7 Believe Me Speech Sharing a Document  Share a document via OneDrive  Assign 
collaboration permission

.75

1.8 How to Get There 2 Editing Basics  Open an existing document from OneDrive  
 Cut, copy, and paste text

.5

1.9 Getting to Know 
You

Working Collaboratively  Edit a document simultaneously with another 
user

.75 - 1

1.10 What Kind of 
Learner Am I?

Customizing the Quick 
Access Toolbar

 Use Undo and Redo  Customize the Quick Access 
toolbar  Use the Tab key to indent paragraphs

.75 - 1

1.11 You Are So Smart Getting Help and 
Information

 Use Tell Me  Insert a cover page  Use Smart 
Lookup  Inspect a document for hidden properties 
or personal information  Add document properties

.75

1.12 My Action Plan Working with PDF File Types  Open a PDF in Word for Editing .5

Part 1 Assessments Performance and Written Assessments are located with the Instructor Resources.

Part 2:  Formatting Text

2.1 Decades of Slang Formatting Text  Apply font formatting  Clear formatting .75

2.2 Top 10 Formulas Enhancing and Formatting 
Text

 Create a numbered list  Apply font 
formatting  Insert special characters

.75

2.3 Back to School BBQ Formatting Text with Effects  Change text effects  Apply a text highlight 
color to text selections  Apply formatting by 
using Format Painter

.5 - .75

2.4 What’s Cooking Enhancing Proofreading 
Skills

 Replace text by using AutoCorrect  Remove a 
word from AutoCorrect

.75

Part 2 Assessments Performance and Written Assessments are located with the Instructor Resources.

Curriculum Guide
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Lesson Skills

Approximate  
Completion Time 

(in hours)

Part 3:  Formatting Paragraphs & Editing Text

3.1 Spirit Team Promo Changing Paragraph Line 
Spacing

 Set line and paragraph spacing and 
indentation  Show or hide formatting symbols

.75

3.2 Homecoming 
Weekend  
Invitation

Applying Text Alignment  Use a soft return  Use a hard return  Change 
text alignment  Add borders

.5 - .75

3.3 There’s an App for 
That

Using Indents and Paragraph 
Spacing

 Set line and paragraph spacing and 
indentation

.5

3.4 I’m So Bored! Creating Lists  Create a numbered or bulleted list  Increase or 
decrease list levels  Set starting number value  
 Restart or continue list numbering  Change 
bullet characters or number formats for a list level 
 Define a custom bullet character or number

1

3.5 A-Z Guide for 
School Success

Applying Background 
Shading and Sorting Text

 Sort paragraph text  Shade background of 
text

.75

3.6 Letter to an  
Incoming  
Freshman

Using Find and Replace  Find and replace text  Find and replace text 
formatting

.75

3.7 Something Like 
That

Proofing Your Document   Use Spelling & Grammar Check  Use the 
Thesaurus  Use Word Count  Use Character 
Count

.5 - .75

3.8 Kids Who Code 
Meeting Minutes

Applying Text Styles  Apply built-in styles to text  Create and save 
a style

.75

3.9 Kids Who Code 
Meeting Minutes 2

Applying Hyperlinks to Text  Use the Style Inspector  Insert hyperlinks  
 Apply document style sets 

.5

3.10 Gluten Free Mac 
and Cheese

Reinforcement Lesson There are no new skills being introduced in this 
lesson.

.5

Part 3 Assessments Performance and Written Assessments are located with the Instructor Resources.

Part 4:  Working with Tables

4.1 Midterm Exam 
Schedule

Using Table Basics  Create a table by specifying rows and columns 
 Change cell alignment  Resize rows and 
columns

.5

4.2 Midterm Exam 
Schedule 2

Working with Rows, 
Columns, and Cells

 Vertically center a table on a page  Insert and 
delete rows, columns, and cells  Merge and 
split cells

.5

4.3 City Life Formatting Tables  Shade cells, rows, and columns  Apply 
borders  Configure cell margins and spacing  
 Resize tables

.5

4.4 City Life 2 Enhancing Tables with 
Styles

 Apply table styles  Modify table styles .5
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Lesson Skills

Approximate  
Completion Time 

(in hours)

4.5 MLB All-Time 
Leaders

Working with Data in a 
Table

 Sort table data  Change text direction in a 
table

.75

4.6 Let’s Make a Date Using Quick Tables  Use Quick Tables  Use AutoFit to resize tables .75

4.7 Career and  
Technical  
Education

Modifying a Table  Configure a repeating row header  Split 
tables

.75

4.8 Shopping List Performing Calculations in 
a Table

 Calculate the sum of a column or row  Find 
the average of a column or row  Determine 
the product of a row  Format the results of a 
formula  Toggle field codes  Update a formula

.75

4.9 School Fundraiser Working with Excel in Your 
Document

 Insert a table as an Excel spreadsheet  Use 
SUM, AVERAGE, MIN, and MAX functions  
 Change number format in a spreadsheet  Use 
Fill options

.75

4.10 Career  
Exploration

Inserting Objects  Insert text from a file or external source .75

Part 4 Assessments Performance and Written Assessments are located with the Instructor Resources.

Part 5:  Working with Tabs

5.1 Guidance  
Counselor  
Caseloads

Using Tab Basics  View the Ruler  Use the default tab .5

5.2 Hot Jobs Converting Text to Tables  Set tabs using the ruler  Convert text to 
tables

.75

5.3 Kid Millionaires Setting Custom Tabs  Set tabs using the dialog box  Use dot 
leaders

.5

5.4 Shopping List 2 Converting Tables to Text  Convert tables to text .5

5.5 Honors Night 
Program

Changing Tab Alignment  Clear tabs .75

5.6 World’s Best Ferris 
Wheels

Reinforcement Lesson There are no new skills being introduced in this 
lesson.

.5

Part 5 Assessments Performance and Written Assessments are located with the Instructor Resources.

Part 6:  Working with Columns and Page Setup

6.1 ID Theft Formatting Text into 
Columns

 Format text in multiple columns  Modify 
page setup

.75

6.2 Password Power Using Column Breaks  Modify page setup  Insert column breaks .75

6.3 Top Performers Enhancing the Appearance 
of the Page

 Modify page setup  Format page background 
elements  Insert section breaks  Change page 
setup options for a section

.75

6.4 ID Theft 2 Adding a Cover Page to a 
Document

 Insert a cover page  Format page 
background elements

.75
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Lesson Skills

Approximate  
Completion Time 

(in hours)

6.5 Password Power 2 Enhancing Document 
Columns

 Apply hyphenation  Adjust column width .5

Part 6 Assessments Performance and Written Assessments are located with the Instructor Resources.

Part 7:  Using Headers, Footers & References

7.1 Student Council 
Letterhead

Using Headers and Footers  Insert headers and footers .75

7.2 Classroom Rules Formatting Headers and 
Footers

 Insert a date  Insert page numbers  Insert 
page breaks  Insert a signature line

.75 - 1

7.3 ID Theft 3 Advanced Headers and 
Footers

 Insert headers and footers for a section 
 Insert headers and footers for even/odd pages 
 Change page setup options for a section

.5 - .75

7.4 Job Descriptions Working with Bookmarks  Create bookmarks  Insert hyperlinks .75

7.5 Protect Yourself Working with a Table of 
Contents

 Insert a standard Table of Contents  Update a 
Table of Contents

.75 - 1

7.6 Protect Yourself 2 Working with Citations  Create bibliography citation sources  Modify 
bibliography citation sources  Insert citations 
for bibliographies

.75 - 1

7.7 Risks and Rewards 
of Social Media

Working with a Table of 
Figures

 Insert figure and table captions  Modify 
caption properties  Modify styles  Insert and 
update a Table of Figures

.75

7.8 Waiver and  
Release Form

Working with Footnotes 
and Endnotes

 Insert footnotes and endnotes  Modify 
footnote and endnote properties

.75 - 1

7.9 Needs vs. Wants Navigating a Document 
Efficiently

 Split the window  Search for text  Move to a 
specific location or object in a document

.75 - 1

Part 7 Assessments Performance and Written Assessments are located with the Instructor Resources.

Part 8:  Working with Graphics and Visual Elements

8.1 High School Musical 
Auditions Flyer

Inserting and Working with 
Pictures

 Insert a picture  Wrap text around objects 
 Format objects  Position objects 

.75

8.2 Letterhead with 
Picture

Formatting Picture Styles  Apply a picture style  Format objects .5

8.3 Start Saving Combining Pictures with Text  Wrap text around objects  Position objects .75

8.4 Life Cycle of a 
Butterfly

Using Shapes  Create a SmartArt graphic  Modify SmartArt 
graphic content  Format a SmartArt graphic 
 Insert shapes  Format objects  Align objects 
 Group objects

1

8.5 Visual Resume Working with Graphic 
Elements

 Use WordArt  Insert text boxes  Use 
alignment guides  Distribute objects

1

8.6 YouTube  
Superstars

Inserting an Online Video  Insert an online video  Crop a picture 
 Format objects

.75
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Lesson Skills

Approximate  
Completion Time 

(in hours)

8.7 Just Google It Inserting a Screenshot  Insert a screenshot or screen clipping .75

8.8 Slater Farms Enhancing Pictures  Insert pictures  Apply artistic effects  Apply 
picture effects  Remove picture backgrounds

.75

8.9 Slater Farms 2 Working with Accessibility 
and Compatibility Issues

 Change text to WordArt  Inspect a document 
for accessibility issues  Add alternative text to 
objects for accessibility  Inspect a document 
for compatibility issues

.75

Part 8 Assessments Performance and Written Assessments are located with the Instructor Resources.

Part 9:  Using Templates

9.1 Excellence in 
Photography

Creating an Award 
Certificate

 Create a blank document using a template - 
Certificate

.5

9.2 Internship  
Newsletter

Creating a Newsletter  Create a blank document using a template - 
Newsletter  Apply document themes

.75

9.3 What’s New in 
2016

Creating a Blog Post  Create a blank document using a template - 
Blog Post

.75

Part 9 Assessment Performance Assessment is located with the Instructor Resources.

Part 10:  Sharing and Working Collaboratively

10.1 Step By Step Managing Shared Files  Share a document  Assign collaboration 
permission  Copy and move shared files

.75

10.2 Feedback 101 Managing Revisions  Edit documents with Word Online  Review 
version history

.5

10.3 Who Am I Using Comments While 
Collaborating

 Collaborate simultaneously  Use comments  
 Hide comments

.75

10.4 Finding a Career Reinforcement Activity There are no new skills being introduced in this 
lesson.

.75

Part 10 Assessments Performance and Written Assessments are located with the Instructor Resources.

Total Completion Time: 46 - 49

MOS Practice Tests MOS Practice Tests are located with the Instructor Resources.
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Part 1
Document Basics

1.1 Oh, the Places You’ll Save! 
Exploring Places to Save Work

1.2 Getting Started
Navigating Word

1.3 Start of the Year Goals
Creating Your First Document

1.4 How to Get There
Saving to OneDrive

1.5 Start of the Year Goals 2
Retrieving a Document

1.6 Believe Me Ideas
Emailing a Document

1.7 Believe Me Speech
Sharing a Document

1.8 How to Get There 2
Editing Basics

1.9 Getting to Know You
Working Collaboratively

1.10 What Kind of Learner Am I?
Customizing the Quick Access Toolbar

1.11 You Are So Smart
Getting Help and Information

1.12 My Action Plan
Working with PDF File Types

Part 1 Assessments
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Browse: 
Use the Backstage View to Browse the 
different places where your document 
can be saved. 

Save: 
Use the Backstage View to Save your 
document the first time. 

 Note: You will be prompted to give 
the document a file name the first time 
you save it. 

Blank Document: 
Allows you to begin using a new blank 
document. 

Alternatively, a quick way to Save is to use the Save 
icon located on the Quick Access Toolbar. 

Close: 
Use the Backstage View to Close the 
document you are working in. 

Zoom Settings: 
Use Zoom settings to customize 
the view of your document. 

Lesson 1.3 

Tools & Terms
Review the following tools that you will learn and practice using in this lesson, as you may be required to take an 
assessment after completing this part.

Skills
  Create a blank 
document

  Customize views by 
using zoom settings

� Save a document to 
a local hard drive or 
network drive

� Close a document 

Part 1: Document Basics 

Start of the Year 
Goals
Creating Your First Document

Lesson Overview
When creating a document, oftentimes you will want to save a document for 
future use. It’s important that you save your work in a folder so that you can 
retrieve it easily and make edits as necessary. Changing the zoom setting 
of your document does not affect the document content, but may make it 
easier for you to read your text, or evaluate how the text is distributed on 
the page. At the start of each school year, Ms. Miller asks her students to set 
goals for the year. Having a goal gives you something to work for and holds 
you accountable to the efforts required to achieve that goal. Ms. Miller’s 
students are required to set goals that are specific, measurable, attainable, 
relevant, and time sensitive—also known as SMART goals. Writing a goal this 
way makes it more structured and quantifiable. Each goal details the actual 
plan of action the student will take to achieve the goal.

In this lesson, you will create and save a new document detailing the goals a 
student might make on the first day of school.
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1. Before you begin working in Word, if you haven’t already done so in Lesson 1.1, 
be sure you have created a folder on your hard drive or network drive called 
My Word Projects.

2. Launch Word 2016.

3. From the Start screen, select Blank document.

4. At the top of the document where the insertion point (cursor) is flashing, key 
the text as shown in Figure 1.3.

5. To increase and decrease the zoom setting of your page, from the View tab, 
Zoom group (shown below), do the following:

a. Click Zoom. 

b. Select one of the settings in the Zoom dialog box, and click OK. 

6. To return to the original zoom setting, from the View tab, Zoom group,  
click 100%.

7. Proofread your document for accuracy and format.

 Note: You will be learning how to use Word’s Spelling & Grammar features a 
bit later. However, you are always responsible for proofreading your document.

8. From the File tab, click Save.

9. Click the Browse button and locate the folder named My Word Projects on 
your hard drive or network drive. Name the file 1.3 Start of the Year Goals and 
click Save.

10. From the File tab, click Close.

11. Close Word by clicking on the X in the top right corner of the screen. 

3.

9.

8.

10.

5b.

8.

Creating Your First Document Lesson 1.3

Instructions
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Start of the Year SMART Goals 

Throughout the school year, I will take notes on new material and review those notes at least three days 
prior to a test or quiz so that I can ask questions in time to be prepared and score above 85% on the 
assessment. 

For the upcoming year, each day I will complete any homework assigned to me before hanging out with 
friends, watching TV, or playing video games so that I can earn 100% each day on homework 
assignments that are due. 

For the next month, I will get to bed before 9 pm in order to develop a yearlong habit of getting nine 
hours of sleep on school days. 

During this school year, I will attend some school related sporting events, music performances, or 
theater productions to show my school spirit and make long-lasting memories with my friends. 

Figure 1.3

Lesson 1.3 Creating Your First Document
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OneDrive: 
OneDrive is an Internet-based cloud 
storage platform that is equipped 
with word processing, spreadsheet, 
presentation, and other applications. 

Lesson 1.4

Tools & Terms
Review the following tool that you will learn and practice using in this lesson, as you may be required to take an 
assessment after completing this part.

New Skills
� Save a document to 
OneDrive

Part 1: Document Basics 

How to Get There
Saving to OneDrive

Lesson Overview
Saving documents and files to your cloud storage application gives you mobile 
access to your work. Your OneDrive account provides space to save and upload 
documents that you have created in Microsoft Word. Before attempting to 
create folders and save documents to your cloud storage, you must be logged 
in to your OneDrive account. Files can then be retrieved from either File 
Explorer, OneDrive.com, or by opening them from the File tab in Word. 

In this lesson, you will create a new document that lists the steps for achieving a 
goal. You will save this document to your OneDrive account.
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1. Before you begin working in Word, if you haven’t already done so in Lesson 1.1, 
be sure you have created a folder on your OneDrive called My Online Word 
Projects.

 Note: Be sure your teacher or network administrator has configured your 
computer login to sync with your OneDrive account.

 Note: The name of your OneDrive may differ depending on the version of 
Microsoft Word you are using. This does not affect your ability to save and 
recall files to and from your OneDrive.

2. Launch Word 2016.

3. From the Start screen, select Blank document.

4. At the top of the document where the insertion point (cursor) is flashing, key 
the text as shown in Figure 1.4.

5. Proofread your document for accuracy and format.

6. To save your document to OneDrive, do the following (as shown below):

a. From the File tab, click Save.

b. Click the Browse button then click OneDrive.

c. Double click the folder called My Online Word Projects. 

d. Name the file 1.4 How to Get There. 

e. Click Save.

7. From the File tab, click Close.

8. Close Word by clicking on the X in the top right corner of the screen. 

6b.
6c.

6d.

6e.

Saving to OneDriveLesson 1.4

Instructions
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Steps for Achieving a Goal 

Define your goal – Write down your SMART goals. 

Divide your goal into smaller parts – Break up the goal into more manageable parts, or sub-goals, 
especially in the case of a long-term goal. This will help you accomplish your goal. 

Identify steps within each sub-goal – Identify the smaller, manageable steps necessary to be successful. 
A daily “to-do” list is perfect for helping with this. 

Plan for the unexpected – Have a “what if” plan in place to address obstacles along the way. 

Review your progress along the way – Don’t be afraid to reassess and modify your goal if necessary. 

Figure 1.4

Lesson 1.4Saving to OneDrive
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Part 2
Formatting Text

2.1 Decades of Slang
Formatting Text

2.2 Top 10 Formulas
Enhancing and Formatting Text

2.3 Back to School BBQ
Formatting Text with Effects

2.4 What’s Cooking
Enhancing Proofreading Skills

Part 2 Assessments
Performance and Written Assessments are located with the Instructor 
Resources.
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Font:  
Use the drop-down menu to select 
a new font for your text. 

Font Size:  
Use the drop-down menu to change 
the size of your text. 

Font Color:  
Use the drop-down menu to change 
the color of your text. 

Bold:  
Use this icon to make your text bold 
for emphasis. 

Italic:  
Use this icon to italicize your text.

Underline:  
Use this icon to underline your text.

Strikethrough:  
Use this icon to cross something out by 
drawing a line through it. 

Clear All Formatting:  
Use this icon to remove all formatting 
(such as bold, italics, underline, and 
strikethrough) from the selection, leaving 
only the normal, unformatted text.

Lesson 2.1 

Tools & Terms
Review the following tools that you will learn and practice using in this lesson, as you may be required to take an 
assessment after completing this part.

Skills
  Apply font formatting

  Clear formatting

Part 2: Formatting Text 

Decades of Slang
Formatting Text

Lesson Overview
Although you may only think of a document as a form of written 
communication, your document is also a form of visual communication. 
The way your text appears can help the reader better understand the 
document’s contents. Bolding, underlining, and italicizing text, as well as 
changing the font style and font size, all add to the appearance of your 
work. The process is the same for all formatting changes—select the text and 
apply the format. 

In this lesson, you will create a list of popular slang words teens used each 
decade from the 1920’s until the 2000’s. You will also be introduced to some of 
the most common formatting options in Word.
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1. Using Word 2016, create a new Blank document.

2. Save the file as 2.1 Decades of Slang in your My Word Projects folder on your 
hard drive or network drive.

3. At the top of the document, key the text as shown in Figure 2.1 A.

4. From the Home tab, Font group, select the required text and do the following:

a. Change the font of the entire document to Georgia. 

b. Change the font size of the title [Decades of Slang] to 22.

c. Bold the text for each decade. 

 Hint: Hold down the CTRL key as you double click each year.

d. Underline the text for each decade.

e. Bold each slang phrase. 

 Hint: Hold down the CTRL key as you drag your mouse over the phrase.

f. Italicize each meaning of the slang phrase.

g. Using the Clear All Formatting tool, clear the previously applied 
formats to the last definition [beyond cool].

h. Change the color of [Sitting in the hot seat – in a highly uncomfortable or 
embarrassing situation] to Red. 

i. Apply Strikethrough to [My bad – my mistake].

j. Change the font size of the text for each decade to 16.

5. Proofread your document for accuracy and format, then resave the file.

6. Print preview. Your document should look similar to Figure 2.1 B.

7. Print or share the document if required by your instructor.

4.

4a.

4h.

4b.

Formatting Text Lesson 2.1

Instructions
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Decades of Slang 

1930’s 

I'll be a monkey's uncle – sign of disbelief; I don't believe it! 

Gig – a job 

1940’s 

Cool – excellent; clever; sophisticated; fashionable; or enjoyable 

Sitting in the hot seat – in a highly uncomfortable or embarrassing situation 

1950’s 

Big brother is watching you – someone of authority is monitoring your actions 

Hipster – an innovative and trendy person 

1960’s 

Groovy – cool; hip; excellent 

The Man – a person of authority; a group in power 

1970’s 

Catch you on the flip side – see you later 

Dig it – to like or understand something 

1980’s 

Chillin' – relaxing 

Gag me with a spoon – disgusting 

1990’s 

My bad – my mistake 

Wassup? – What's up?; How are you? 

2000’s 

Newbie – a newcomer; someone who is inexperienced 

Peeps – friends; people 

Sweet – beyond cool 

 

Figure 2.1 A

Lesson 2.1 Formatting Text
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Decades of Slang
1930’s
I'll be a monkey's uncle – sign of disbelief; I don't believe it!

Gig – a job

1940’s
Cool – excellent; clever; sophisticated; fashionable; or enjoyable

Sitting in the hot seat – in a highly uncomfortable or embarrassing situation

1950’s
Big brother is watching you – someone of authority is monitoring your actions

Hipster – an innovative and trendy person

1960’s
Groovy – cool; hip; excellent

The Man – a person of authority; a group in power

1970’s
Catch you on the flip side – see you later

Dig it – to like or understand something

1980’s
Chillin' – relaxing

Gag me with a spoon – disgusting

1990’s
My bad – my mistake

Wassup? – What's up?; How are you?

2000’s
Newbie – a newcomer; someone who is inexperienced

Peeps – friends; people

Sweet – beyond cool

Figure 2.1 B

Lesson 2.1Formatting Text
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Subscript:  
Use this icon to make a letter or number smaller 
and then move it just below the line of text.

Increase Font Size:  
Use this icon to make your text bigger in 
point size.  

Decrease Font Size:  
Use this icon to make your text smaller in 
point size.  

Superscript:  
Use this icon to make a letter or number smaller 
and then move it just above the line of text.

Change Case:  
Use this icon to change the selected text to uppercase, 
lowercase, or other common capitalization styles.

Numbering:  
Use this icon to create a numbered list. The drop-down 
menu provides more numbering formats to choose from. 

Special Characters: 
Use this dialog box, from the Insert tab, Symbols 
group, to insert special characters, such as an em 
dash (—), which are not found on your keyboard. 

Lesson 2.2 

Tools & Terms
Review the following tools that you will learn and practice using in this lesson, as you may be required to take an 
assessment after completing this part.

Part 2: Formatting Text 

Top 10 Formulas
Enhancing and Formatting Text

Lesson Overview
There are many ways to enhance and format the text in a document in 
addition to bold, underline, and italics. Suppose you typed in lowercase 
and later decided the text should be all caps, or wanted to quickly number 
a list of items with Roman numerals? Using the Tell Me feature allows you 
to quickly get commands to insert the exact symbol or formula you are 
looking for without having to search for it in a gallery. In addition, text can 
be formatted as superscript or subscript, and thousands of other symbols 
and special characters are also available.

In this lesson, you will create a list of the top 10 formulas everyone should know.

Skills
  Create a numbered list

  Apply font formatting

  Insert special characters
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1. Using Word 2016, create a new Blank document.

2. Save the file as 2.2 Top 10 Formulas in your My Word Projects folder on your 
hard drive or network drive.

3. At the top of the document, key the text exactly as shown in Figure 2.2 A.

4. From the Home tab, Paragraph group, apply Numbering to the list of 
equations.

 Hint: Use Figure 2.2 B as a reference as you complete this lesson.

5. From the Home tab, Font group, do the following: 

a. Increase the font size of [Top 10 Formulas Everyone Should Know] to 20.

b. Decrease the font size of [(according to me)] to 9.

c. Apply Superscript to the number [2] in Formula 5 and Formula 8.

d. Apply Superscript to the number [3] to the right of [r] in Formula 7.

e. Apply Subscript to the numbers [1 and 2] in Formula 10.

f. Change Case of [(according to me)] to UPPERCASE.

g. Key [equation symbol] in the Tell me field to find and insert the symbol 
for Pi [π] before the [r3] in Formula 7.

h. Use Tell Me to find and insert the equation for the area of a circle after the 
colon in Formula 6.

6. Delete the parentheses around the text [ACCORDING TO ME].

7. To insert a special character such as an em dash (—), from the Insert tab, 
Symbols group (shown below), do the following:

a. Position your cursor immediately to the left of the text [ACCORDING].

b. From the Symbol drop-down menu, select More Symbols….

c. From the Symbol dialog box, Special Characters tab, select Em Dash, click 
Insert, and then Close.

8. Proofread your document for accuracy and format, then resave the file.

9. Print preview. Your document should look similar to Figure 2.2 B.

10. Print or share the document if required by your instructor.

4.5.

5f.

5g.

7b.

7c.

Enhancing and Formatting Text Lesson 2.2

Instructions
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Top 10 Formulas Everyone Should Know (according to me) 

 

Percent = Part/Whole 

Average = Total/Number of Things 

Probability = (Desired Possibilities/Total Possibilities) 

Distance = Rate x Time 

Area of a Square, where a = side: A = a2 

Area of a Circle, where r = radius:  

Volume of a Sphere, where r = radius: V = 4/3 r3 

Surface Area of a Cube = 6s2 

Formula for a Standard Line: y = mx+b 

Slope Equation: (y2‐y1)/(x2‐x1) 

Figure 2.2 A

Lesson 2.2 Enhancing and Formatting Text
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Top 10 Formulas Everyone Should Know —ACCORDING TO ME 

 

1. Percent = Part/Whole 
2. Average = Total/Number of Things 
3. Probability = (Desired Possibilities/Total Possibilities) 
4. Distance = Rate x Time 
5. Area of a Square, where a = side: A = a2 
6. Area of a Circle, where r = radius:   
7. Volume of a Sphere, where r = radius: V = 4/3 πr3 
8. Surface Area of a Cube = 6s2 
9. The Formula for a Standard Line: y = mx+b 
10. The Slope Equation: (y2‐y1)/(x2‐x1) 

Figure 2.2 B

Lesson 2.2Enhancing and Formatting Text
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Part 3
Formatting 
Paragraphs & 
Editing Text3.1 Spirit Team Promo

Changing Paragraph Line Spacing

3.2 Homecoming Weekend Invitation
Applying Text Alignment

3.3 There’s an App for That
Using Indents and Paragraph Spacing

3.4 I’m So Bored!
Creating Lists

3.5 A-Z Guide for School Success
Applying Background Shading and Sorting Text

3.6 Letter to an Incoming Freshman
Using Find and Replace

3.7 Something Like That
Proofing Your Document

3.8 Kids Who Code Meeting Minutes
Applying Text Styles

3.9 Kids Who Code Meeting Minutes 2
Applying Hyperlinks to Text

3.10 Gluten Free Mac and Cheese
Reinforcement Lesson

Part 3 Assessments
Performance and Written Assessments are located with the Instructor 
Resources.
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Line and Paragraph Spacing: 
Use this drop-down menu to choose how much space 
appears between lines of text or between paragraphs.

Show/Hide: 
Use this icon to show/hide paragraph marks 
and other hidden formatting symbols.

Paragraph Dialog 
Box: 
Use this dialog box to 
edit the line spacing 
and paragraph 
indent options of 
your document or 
selected text. 

Lesson 3.1 

Tools & Terms
Review the following tools that you will learn and practice using in this lesson, as you may be required to take an 
assessment after completing this part.

Skills
  Set line and paragraph 
spacing and indentation

  Show or hide formatting 
symbols

Part 3: Formatting Paragraphs & Editing Text 

Spirit Team Promo
Changing Paragraph Line Spacing

Lesson Overview
As a default, Microsoft Word 2016 is set to have multiple line spacing in 
paragraphs and additional spacing after paragraphs. Leaving space within, 
before, and after paragraphs may increase the readability of the document. 
However, there will be times when you wish to change the line spacing for 
all or part of a document. In fact, some types of documents require specific 
spacing, such as business style letters or academic reports. Changing line 
spacing can be done quickly from an icon on the Home tab, but more 
specific changes, including paragraph indentation, are best done in the 
Paragraph dialog box. It is also smart to utilize the Show/Hide feature, which 
when toggled reveals when you have used the space bar, Tab key, or the 
Enter key throughout your document.

In this lesson, you will type an announcement for the school to promote the 
formation of a school spirit team.
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1. Using Word 2016, create a new Blank document.

2. Save the file as 3.1 Spirit Team Promo in your My Word Projects folder on your 
hard drive or network drive.

3. At the top of the document, key the text as shown in Figure 3.1 A.

 Note: Use the Tab key as necessary to separate the captains’ names on the 
last line.

4. Make the following formatting changes to the title [Spirit Team Promo] on the 
first line:

a. Change the font size to 24.

b. Apply bold.

c. Apply an Orange text effect of your choice.

5. From the Home tab, Paragraph group, do the following:

a. Select all of the body text of the document, excluding the title, and change 
the Line Spacing to 2.0.

b. Click the Show/Hide button to view the hidden formatting symbols.

6. Select all of the body text of the document, excluding the title and the last line, 
then launch the Paragraph dialog box and do the following:

a. From the Indentation section, Special drop-down menu, select First line. 
Notice that the By field changes to 0.5”.

b. Check the Don’t add space between paragraphs of the same style 
checkbox.

c. Click OK to apply the changes.

7. Proofread your document for accuracy and format, then resave the file.

8. Print preview. Your document should look similar to Figure 3.1 B.

9. Print or share the document if required by your instructor.

5.

5a.

6b.

6.

6a.

6c.

Changing Paragraph Line Spacing Lesson 3.1

Instructions
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Spirit Team Promo 

Our high school is such an amazing place! We have award winning theater, music, and sports programs. 
Our students are dedicated to our school and show their school spirit by attending plays, musicals, 
concerts, and games. Our mascot does a fantastic job at all football, soccer, hockey, and basketball 
games. Even the students who do not participate in any extracurricular activities show their school spirit 
when they come out to support their fellow classmates. But this just isn’t enough. 

In the coming school year, we will form our first spirit team to perform at varsity basketball games. The 
team will hold auditions in the fall and will practice twice a week to prepare for the winter basketball 
season. If the team is successful, we will expand to other sports the following year. 

Led by a dance teacher/choreographer, practices will include team building, warm‐ups, stretching, 
technique instruction, as well as learning, reviewing, and perfecting performance routines. 
Performances in the dance style of cheer, jazz, and hip‐hop will be done by the team at pep rallies and 
home basketball games. If interested, contact the following captains in Room 220: 

Gabby Townsend, Captain    Jenna Hodgkinson, Co‐Captain    Liz Conner, Co‐Captain 

Figure 3.1 A

Lesson 3.1 Changing Paragraph Line Spacing
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Our high school is such an amazing place! We have award winning theater, music, and sports 

programs. Our students are dedicated to our school and show their school spirit by attending plays, 

musicals, concerts, and games. Our mascot does a fantastic job at all football, soccer, hockey, and 

basketball games. Even the students who do not participate in any extracurricular activities show their 

school spirit when they come out to support their fellow classmates. But this just isn’t enough. 

In the coming school year, we will form our first spirit team to perform at varsity basketball 

games. The team will hold auditions in the fall and will practice twice a week to prepare for the winter 

basketball season. If the team is successful, we will expand to other sports the following year. 

Led by a dance teacher/choreographer, practices will include team building, warm‐ups, 

stretching, technique instruction, as well as learning, reviewing, and perfecting performance routines. 

Performances in the dance style of cheer, jazz, and hip‐hop will be done by the team at pep rallies and 

home basketball games. If interested, contact the following captains in Room 220: 

Gabby Townsend, Captain    Jenna Hodgkinson, Co‐Captain    Liz Conner, Co‐Captain 

Figure 3.1 B

Lesson 3.1Changing Paragraph Line Spacing
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Justify: 
Use this icon to distribute your text evenly 
between the left and right margins. 
Justified text gives your document clean, 
crisp edges so it looks more polished. 

Borders: 
Use the drop-down menu to add or 
remove borders from your selection. 

Align Left: 
Use this icon to align your text to the 
left margin. Commonly used for body 
text, using left alignment makes the 
document easier to read. 

Center: 
Use this icon to horizontally center your 
text on the page. Centering text is often 
used with titles and cover pages.

Align Right: 
Use this icon to align text to the right 
margin. Right aligning text is commonly 
used for page numbers or text in the 
header or footer of your document. 

Enter

Enter

Soft Return: 
Use a soft return to signify the end of a 
line.

Shift

+

Hard Return: 
Use the Enter key when you have reached 
the end of a paragraph and want to start 
a new one.

Lesson 3.2 

Tools & Terms
Review the following tools that you will learn and practice using in this lesson, as you may be required to take an 
assessment after completing this part.

Part 3: Formatting Paragraphs & Editing Text 

Homecoming 
Weekend Invitation
Applying Text Alignment

Lesson Overview
Text can be formatted to be positioned both horizontally and vertically on the page. It can be aligned with the 
left or right margin, centered between margins, or fully justified on the page as you would see in a newspaper 
or magazine. Paragraphs end when the Enter key is hit. However, there may be times when you want to force 
your cursor down to the next available line without creating a new paragraph. Use a soft return, or text wrapping 
break, to start a new line that is considered to be in the same paragraph as the previous line. This will allow you to 
format all of the text as if it were an entire paragraph.

In this lesson, you will design a homecoming invitation for alumni. Applying text alignment and borders will give the 
invitation a more professional look.

Skills
� Use a soft return

� Use a hard return

� Change text alignment

� Add borders
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1. Using Word 2016, create a new Blank document.

2. Save the file as 3.2 Homecoming Weekend Invitation in your My Word Projects 
folder on your hard drive or network drive.

3. Click the Show/Hide icon to view the hidden formatting symbols.

4. At the top of the document, key the text as shown in Figure 3.2 A. Use a  
Soft Return ( ) (Shift + Enter) and a Hard Return (¶) (Enter) as indicated in 
Figure 3.2 A.

5. Change the font of the entire invitation text to Footlight MT Light and the font 
size to 14.

6. From the Home tab, Paragraph group, do the following:

a. Center the text in the first paragraph.

b. Right align the text in the third and fifth paragraphs.

c. From the Borders drop-down menu, select Outside Borders to add an 
outside border to only the text in the entire document.

7. Proofread your document for accuracy and format, then resave the file.

8. Print preview. Your document should look similar to Figure 3.2 B.

9. Print or share the document if required by your instructor.

6.

6c.

Applying Text Alignment Lesson 3.2

Instructions
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The Junior Class of 
Morton High School 
Invites You to 
Homecoming Weekend 20xx 

 

Friday, October 21, 20xx 
Friday Night Lights Football Game vs. Hilltop High School 
At seven o’clock in the evening 

 

Saturday, October 22, 20xx 
Morton High School Annual Spirit Parade 
Main Street 
At ten o’clock in the morning 

 

Saturday, October 22, 20xx 
“Rock Around the Clock” Homecoming Dance 
At seven thirty in the evening 

 

Sunday, October 23, 20xx 
Homecoming Brunch 
Morton High School Cafeteria 
At eleven o’clock in the morning 

 

RSVP to Mrs. Percy by October 1, 20xx 

 

 

 

 

 

 

 

 

 

¶

¶

¶

¶

¶

¶

¶

¶

¶

¶

Figure 3.2 A

Lesson 3.2 Applying Text Alignment
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The Junior Class of 
Morton High School 

Invites You to 
Homecoming Weekend 20xx 

 

Friday, October 21, 20xx 
Friday Night Lights Football Game vs. Hilltop High School 
At seven o’clock in the evening 

 

Saturday, October 22, 20xx 
Morton High School Annual Spirit Parade 

Main Street 
At ten o’clock in the morning 

 

Saturday, October 22, 20xx 
“Rock Around the Clock” Homecoming Dance 
At seven thirty in the evening 

 

Sunday, October 23, 20xx 
Homecoming Brunch 

Morton High School Cafeteria 
At eleven o’clock in the morning 

 

RSVP to Mrs. Percy by October 1, 20xx 

Figure 3.2 B

Lesson 3.2Applying Text Alignment
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Part 4
Working with 
Tables

4.1 Midterm Exam Schedule
Using Table Basics

4.2 Midterm Exam Schedule 2
Working with Rows, Columns, and Cells

4.3 City Life
Formatting Tables

4.4 City Life 2
Enhancing Tables with Styles

4.5 MLB All-Time Leaders
Working with Data in a Table

4.6 Let’s Make a Date
Using Quick Tables

4.7 Career and Technical Education
Modifying a Table

4.8 Shopping List
Performing Calculations in a Table

4.9 School Fundraiser
Working with Excel in Your Document

4.10 Career Exploration
Inserting Objects

Part 4 Assessments
Performance and Written Assessments are located with the Instructor 
Resources.
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Row Height: 
Use this icon to determine the row 
height of selected cells.

Table: 
Use this icon to add a table to 
organize information within your 
document.

Cell Alignment: 
Use this icon to vertically and 
horizontally align text in cells.

Column Width: 
Use this icon to determine the 
column width of selected cells.

The drop-down 
menu allows you to 
select the number 
of rows and 
columns for your 
table.

Lesson 4.1 

Tools & Terms
Review the following tools that you will learn and practice using in this lesson, as you may be required to take an 
assessment after completing this part.

Skills
  Create a table by 
specifying rows and 
columns

� Change cell alignment

  Resize rows and 
columns

Part 4: Working with Tables 

Midterm Exam 
Schedule
Using Table Basics

Lesson Overview
A table is a graphic element in your document made up of columns and 
rows. A creative way to remember the difference between columns and rows 
is to close your eyes and imagine your dream house. It is a very large two- 
story house with a gorgeous front lawn, beautiful walkway, and grand front 
entrance. The front door is flanked by two large columns on either side of the 
door. Open your eyes and now you know that columns are vertical and rows 
are horizontal. Rows and columns intersect to form cells that can be resized. 

In this lesson, you will create and edit a table to be used for this year’s midterm 
exam schedule.
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1. Using Word 2016, create a new Blank document.

2. Save the file as 4.1 Midterm Exam Schedule in your My Word Projects folder on 
your hard drive or network drive.

3. At the top of the document, key the text [Midterm Exam Schedule] as shown in 
Figure 4.1 A. 

4. From the Insert tab, Tables group, Table drop-down menu, do the following  
(as shown below):

a. Insert a Table with 6 columns and 6 rows.

5. Key the text as shown in Figure 4.1 A.

6. Select row 1 and do the following:

a. From the Table Tools, Layout tab, Alignment group, change the cell 
alignment of the selection to Align Center.

7. Click anywhere within the table, and from the Table Tools, Layout tab, Cell Size 
group, do the following:

a. Select the entire table and adjust the column width of all 
columns to .75”.

b. Select the entire table and adjust the row height of all 
rows to .4”.

8. Center and bold the title [Midterm Exam Schedule], then change the font to 
Stencil and the font size to 18.

9. Proofread your document for accuracy and format, then resave the file.

10. Print preview. Your document should look similar to Figure 4.1 B.

11. Print or share the document if required by your instructor.

7. 6a.

4a.

Using Table Basics Lesson 4.1

Instructions

105Part 4: Working with Tables



Midterm Exam Schedule 

 Monday Tuesday Wednesday Thursday Friday 
      
7:15-9:15 Personal 

Finance 
English US History PE Intro to 

Marketing 
9:20-9:55 Break Break Break Break Break 
10:00-12:00 Statistics Portuguese Chemistry Studio Art History of Jazz 
12:15-1:45 Study Sessions Study Sessions Study Sessions Study Sessions Study Sessions 

 

Figure 4.1 A

Lesson 4.1 Using Table Basics
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MidterM exaM Schedule 

 Monday Tuesday Wednesday Thursday Friday 

      

7:15-9:15 Personal 
Finance 

English US History PE Intro to 
Marketing 

9:20-9:55 Break Break Break Break Break 

10:00-
12:00 

Statistics Portuguese Chemistry Studio 
Art 

History of 
Jazz 

12:15-
1:45 

Study 
Sessions 

Study 
Sessions 

Study 
Sessions 

Study 
Sessions 

Study 
Sessions 

 

Figure 4.1 B

Lesson 4.1Using Table Basics
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Insert Above: 
Use this icon to add a new row directly 
above the current row. 

Insert Below: 
Use this icon to add a new row directly 
below the current row.

Select Tool: 
Use the drop-down menu to select the 
current cell, row, column, or entire table.

Split Cells: 
Use this icon to split the current cell into 
multiple cells. 

Merge Cells: 
Use this icon to merge the selected cells 
into one cell.

Delete: 
Use this icon to delete a cell, column, 
row, or table. 

Insert Left: 
Use this icon to add a new column 
directly to the left of the current 
column.

Insert Right:
Use this icon to add a new column 
directly to the right of the current 
column.

Lesson 4.2 

Tools & Terms
Review the following tools that you will learn and practice using in this lesson, as you may be required to take an 
assessment after completing this part.

Part 4: Working with Tables 

Midterm Exam 
Schedule 2
Working with Rows, Columns, and Cells

Lesson Overview
Changing the layout of your table can drastically improve the readability of your 
work. Cells can be merged or split, and columns and rows can be added or deleted 
at a later time. Customizing your table to look exactly how you want it is done simply 
in Microsoft Word 2016. Individual cells, entire columns, and entire rows can be 
selected with the select tool or your mouse.

In this lesson, you will use the Table Layout features to edit your previously created table.

Skills
� Vertically center a table 
on a page

� Insert and delete rows, 
columns, and cells

  Merge and split cells
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1. Launch Word 2016 and open the file named 4.1 Midterm Exam Schedule from 
your My Word Projects folder on your hard drive or network drive.

2. Save the file as 4.2 Midterm Exam Schedule 2 in your My Word Projects folder 
on your hard drive or network drive.

3. To center the table vertically on the page, from the Layout tab, Page Setup 
group, do the following:

a. Click the Page Setup dialog box launcher (as shown below):

b. From the Page Setup dialog box, Layout tab, Page section, Vertical 
alignment drop-down menu, select Center, then click OK.

4. Click anywhere within the table, and from the Table Tools, Layout tab, Table 
group, do the following:

a. Click the Select tool and choose Select Table. 

b. Change the cell alignment of the table to Align Center.

c. From the Home tab, Paragraph group, horizontally center the table on the page.

5. From the Table Tools, Layout tab, Rows & Columns group, do the following:

a. Place the cursor anywhere in the last row, and click Insert Below to  
add a row at the bottom of the table.

b. Key the text [1:45-3:00] in the first column and [After School Help] in the 
second column.

c. Click anywhere in column 2, and click Insert Left to add a column.

d. Key the text [Friday] in row 1 and [Midterm Review] in row 3.

e. Change the cell alignment of the new column to Align Center.

f. Click anywhere in row 1, and click Insert Above to add a row  
above the days of the week.

g. Key the text [January 20-25] in the first cell of this new row. 

h. Click anywhere in row 3, which is blank, and Delete the row.

4. 5.

4a.

5h.

3b.

Working with Rows, Columns, and Cells Lesson 4.2

Instructions
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6. From the Table Tools, Layout tab, Merge group, do the following:

a. Click in each cell that contains the text [Break] and Split Cells into  
2 columns and 1 row.

b. Key the text [Snack] in the newly split cells.

c. Select all of row 1 and Merge Cells.

d. Select the cell containing the text [Midterm Review] along with  
the four cells below it in the same column and Merge Cells.

e. Select the cell containing the text [After School Help] along with the four 
cells to the right of it in the same row and Merge Cells.

7. Proofread your document for accuracy and format, then resave the file.

8. Print preview. Your document should look similar to Figure 4.2. 

9. Print or share the document if required by your instructor.

6.

6a.

Lesson 4.2 Working with Rows, Columns, and Cells
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MidterM exaM Schedule 

January 20-25 

 Friday Monday Tuesday Wednesday Thursday Friday 

7:15-
9:15 

Midterm 
Review 

Personal 
Finance English US History PE Intro to 

Marketing 
9:20-
9:55 Break Snack Break Snack Break Snack Break Snack Break Snack 

10:00-
12:00 Statistics Portuguese Chemistry Studio Art History of 

Jazz 
12:15-
1:45 

Study 
Sessions 

Study 
Sessions 

Study 
Sessions 

Study 
Sessions 

Study 
Sessions 

1:45-
3:00 After School Help 

 

Figure 4.2

Lesson 4.2Working with Rows, Columns, and Cells
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Part 5
Working with 
Tabs

5.1 Guidance Counselor Caseloads
Using Tab Basics

5.2 Hot Jobs
Converting Text to Tables

5.3 Kid Millionaires
Setting Custom Tabs

5.4 Shopping List 2
Converting Tables to Text

5.5 Honors Night Program
Changing Tab Alignment

5.6 World’s Best Ferris Wheels
Reinforcement Lesson

Part 5 Assessments
Performance and Written Assessments are located with the Instructor 
Resources.
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Ruler: 
Use this icon to see the ruler above 
(horizontal) and to the left (vertical)  
of your document.

Default Tabs: 
The automatic tab stops are at every .5 inches on your 
ruler.

TabTabTabTab

Lesson 5.1 

Tools & Terms
Review the following tools that you will learn and practice using in this lesson, as you may be required to take an 
assessment after completing this part.

Skills
� View the Ruler

� Use the default tab

Part 5: Working with Tabs 

Guidance Counselor 
Caseloads
Using Tab Basics

Lesson Overview
Much like tables, inserting tab stops into a document can help make the 
document neat, organized, and easy to read. As a default, your cursor will 
move .5 inches each time you hit the Tab key. A ruler bar can be displayed 
at the top and side of your page so that you can identify the position of text 
and other elements on your page. If you no longer wish to see the rulers, 
you can uncheck the Ruler box in the View tab.

In this lesson, you will create a list using the default tabs in Word.
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1. Using Word 2016, create a new Blank document.

2. Save the file as 5.1 Guidance Counselor Caseloads in your My Word Projects 
folder on your hard drive or network drive.

3. From the View tab, Show group, do the following:

a. Click in the box in front of the word Ruler (if necessary). 

4. At the top of the document, key the text as shown in Figure 5.1 A.

 Note: Use the Tab key to separate the text into columns as shown.

5. Make the following formatting changes:

a. Center and bold the title.

b. Change the font size of the title to 20.

c. Underline all of the text in the second row so that the entire row is 
underlined.

d. Change the line spacing of the document to 2.0 with no additional space 
before or after paragraphs.

6. Proofread your document for accuracy and format, then resave the file.

7. Print preview. Your document should look similar to Figure 5.1 B.

8. Print or share the document if required by your instructor.

3.

Using Tab Basics Lesson 5.1

Instructions
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Guidance Counselor Caseloads 

Counselor Name  Student Last Names  Grades 

Mrs. Walters   A-M    9 

Ms. Hawkins   N-Z    9 

Mr. Foster   A-P    10 

Mrs. Bell   Q-Z    10 

Ms. Phillips   A-N    11 

Mr. Carr   O-Z    11 

Mrs. Banks   A-L    12 

Ms. Swanson   M-Z    12 



























































































































































Figure 5.1 A

Lesson 5.1 Using Tab Basics
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Guidance Counselor Caseloads 

Counselor Name  Student Last Names  Grades 

Mrs. Walters   A-M    9 

Ms. Hawkins   N-Z    9 

Mr. Foster   A-P    10 

Mrs. Bell   Q-Z    10 

Ms. Phillips   A-N    11 

Mr. Carr   O-Z    11 

Mrs. Banks   A-L    12 

Ms. Swanson   M-Z    12 

Figure 5.1 B

Lesson 5.1Using Tab Basics
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Convert Text to Table: 
Use this icon to change text that has been delimited with 
tabs, commas, or spaces into a table.

Left, Center, and Right Tabs: 
Use these icons to position a tab stop at any position 
along the horizontal ruler. You can click on the tab icon 
on the ruler to cycle through the different types of tabs 
to select the tab type you wish to position.

Lesson 5.2 

Tools & Terms
Review the following tools that you will learn and practice using in this lesson, as you may be required to take an 
assessment after completing this part.

Skills
� Set tabs using the ruler

  Convert text to tables

Part 5: Working with Tabs 

Hot Jobs
Converting Text to Tables

Lesson Overview
You can set tabs in your document so that you can quickly position your 
cursor at any point in a line. By distributing left tab stops evenly throughout 
your document, you can easily align text into columns and enhance the 
appearance of the page. Once set, tab stops continue to work until you clear 
or change them. It is best to set tabs prior to keying text, but if text already 
exists, be sure to select your entire paragraph and adjust the tab stops 
where needed. Once your document has been delimited with tabs, you have 
the option to convert the text into a table. Doing so will add borders to your 
already organized document, making it even easier to read.

In this lesson, you will set tabs to create a list of the best jobs projected for the 
next ten years. Then you will convert the tab-delimited text into a table.
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6.

6a.

6b.

Converting Text to Tables Lesson 5.2

Instructions
1. Using Word 2016, create a new Blank document.

2. Save the file as 5.2 Hot Jobs in your My Word Projects folder on your hard 
drive or network drive.

3. Set a Left Tab stop at 3” and 5” on the horizontal ruler (as shown below):

 Note: Clicking on a position on the ruler places a tab stop at that position.

4. At the top of the document, key the text as shown in Figure 5.2 A.

 Note: Be sure to hit the Tab key between each column as indicated.

5. Make the following formatting changes:

a. Center and bold the title.

b. Change the font size of the title to 18.

c. Change the line spacing of the document to single with no additional 
space before or after paragraphs.

6. Select all of the text, except the title and from the Insert tab, Tables group, do 
the following:

a. From the Table drop-down menu, select Convert Text to Table.

b. From the Convert Text to Table dialog box, be sure the number of 
columns is 3 and the number of rows is 11. Keep all other default settings, 
then click OK. 

7. Bold and apply Gray, Accent 3 shading to the first row. 

8. Proofread your document for accuracy and format, then resave the file.

9. Print preview. Your document should look similar to Figure 5.2 B.

10. Print or share the document if required by your instructor.
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Hot Jobs for the Next 10 Years 

Job Projected Growth Median Annual Salary 

App Developer 22.7% $96,461 

Nurse Practitioner 25.7% $97,396 

Information Security Analyst 30.9% $89,558 

Computer Systems Analyst 22.5% $82,694 

Physical Therapist 25.9% $82,275 

Market Research Analyst 28.2% $62,226 

Medical Sonographer 33.6% $68,886 

Dental Hygienist 21.8% $74,169 

Operations Research Analyst 23.2% $78,070 

Health Services Manager 17.5% $93,338 

 

 

 

 

 

 

 

 

 

 

 

3" 5"

Figure 5.2 A

Lesson 5.2 Converting Text to Tables
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Hot Jobs for the Next 10 Years 
Job Projected Growth Median Annual Salary 
App Developer 22.7% $96,461 
Nurse Practitioner 25.7% $97,396 
Information Security Analyst 30.9% $89,558 
Computer Systems Analyst 22.5% $82,694 
Physical Therapist 25.9% $82,275 
Market Research Analyst 28.2% $62,226 
Medical Sonographer 33.6% $68,886 
Dental Hygienist 21.8% $74,169 
Operations Research Analyst 23.2% $78,070 
Health Services Manager 17.5% $93,338 

 

Figure 5.2 B

Lesson 5.2Converting Text to Tables
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Part 6
Working with 
Columns and 
Page Setup

6.1 ID Theft
Formatting Text into Columns

6.2 Password Power
Using Column Breaks

6.3 Top Performers
Enhancing the Appearance of the Page

6.4 ID Theft 2
Adding a Cover Page to a Document

6.5 Password Power 2
Enhancing Document Columns
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Page Margins:  
Use this drop-down menu to set the 
margin sizes for the entire document or 
the current section.

Columns:  
Use this drop-down menu to 
organize your text into columns.

Lesson 6.1 

Tools & Terms
Review the following tools that you will learn and practice using in this lesson, as you may be required to take an 
assessment after completing this part.

Skills
  Format text in multiple 
columns

  Modify page setup

Part 6: Working with Columns and Page Setup 

ID Theft
Formatting Text into Columns

Lesson Overview
Text can be formatted into columns to give your document a format similar 
to a newspaper or magazine. Information will flow from the bottom of 
the first column to the top of the next column and enhance the layout of 
the page. Text can be fully justified and margins can be changed to take 
advantage of the available space. Columns are often used to guide the 
reader and direct the flow of text.

In this lesson, you will key a report about identity theft, format the page into two 
columns, and adjust the page margins so that your content can fit on one page.
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4a.

4b.

4.

Formatting Text into Columns Lesson 6.1

Instructions
1. Using Word 2016, create a new Blank document.

2. Save the file as 6.1 ID Theft in your My Word Projects folder on your hard drive 
or network drive.

3. At the top of the document, key the text as shown in Figure 6.1 A. 

4. From the Layout tab, Page Setup group, do the following:

a. Select all of the text, except the title, and from the Columns drop-down 
menu, split your text into Two Columns.

b. Click the Margins drop-down menu, and adjust the Margins to Narrow.

5. Make the following formatting changes:

a. Center and bold the title, then change the font size to 20.

b. Justify the text of the columns and change the font size to 14.

6. Proofread your document for accuracy and format, then resave the file.

7. Print preview. Your document should look similar to Figure 6.1 B.

8. Print or share the document if required by your instructor.
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Identity Theft 

Identity theft is when private information, such as your name or Social Security number, is 
stolen and used without permission, usually to commit financial fraud. Identity thieves often 
use cyberspace to find and steal identities, because a great deal of information is available on 
the Web. Identity thieves gather available information from social media accounts and other 
public sites, and they find ways to trick people into revealing even more information. Identity 
thieves can be very clever. Three ways thieves use the Internet to steal private information 
include phone calls, phishing, and public computers.  

Thieves may contact us by phone, pretending to work for legitimate companies or institutions 
that we trust. Since our trust in them has already been established, it does not seem suspicious 
that they are asking for private information, such as account passwords, Social Security 
numbers, or home addresses. Identity thieves may also pretend to be a friend or acquaintance 
in order to obtain private data.  

When thieves send out emails that ask for private information, it is known as phishing. The 
emails may state that you have won a prize and that in order to claim your winnings, you must 
provide specific private information. Other email phishing scams include thieves posing as a 
service provider or a credible company. The emails say there is a problem with your account 
and that in order to resolve it, you must give them some private data or click on a link 
contained in the body of the email. Once you do, malicious viruses can be downloaded to your 
computer which can steal information stored on your computer. They may also record 
keystrokes you make while typing in banking or credit card logins and passwords. 

If a person uses a public computer and leaves without signing out of private accounts, anyone 
using the computer next will have full access to that person’s private information. This is why it 
is important that you always log out of your private accounts when you are finished using them. 

There are many tools in place to help consumers deal with identity theft, but the first step is to 
tell your parents or guardians. If you are worried that private information about yourself may 
be available publicly, it’s important to report it right away so that your identity can be 
protected. If identity theft goes undetected, thieves can use stolen information for a long time, 
creating long-lasting problems. 

Figure 6.1 A

Lesson 6.1 Formatting Text into Columns
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Identity Theft 
Identity theft is when private information, 
such as your name or Social Security 
number, is stolen and used without 
permission, usually to commit financial 
fraud. Identity thieves often use cyberspace 
to find and steal identities, because a great 
deal of information is available on the Web. 
Identity thieves gather available information 
from social media accounts and other public 
sites, and they find ways to trick people into 
revealing even more information. Identity 
thieves can be very clever. Three ways 
thieves use the Internet to steal private 
information include phone calls, phishing, 
and public computers.  

Thieves may contact us by phone, 
pretending to work for legitimate companies 
or institutions that we trust. Since our trust 
in them has already been established, it does 
not seem suspicious that they are asking for 
private information, such as account 
passwords, Social Security numbers, or 
home addresses. Identity thieves may also 
pretend to be a friend or acquaintance in 
order to obtain private data.  

When thieves send out emails that ask for 
private information, it is known as phishing. 
The emails may state that you have won a 
prize and that in order to claim your 
winnings, you must provide specific private 
information. Other email phishing scams 
include thieves posing as a service provider 

or a credible company. The emails say there 
is a problem with your account and that in 
order to resolve it, you must give them some 
private data or click on a link contained in the 
body of the email. Once you do, malicious 
viruses can be downloaded to your 
computer which can steal information 
stored on your computer. They may also 
record keystrokes you make while typing in 
banking or credit card logins and passwords. 

If a person uses a public computer and 
leaves without signing out of private 
accounts, anyone using the computer next 
will have full access to that person’s private 
information. This is why it is important that 
you always log out of your private accounts 
when you are finished using them. 

There are many tools in place to help 
consumers deal with identity theft, but the 
first step is to tell your parents or guardians. 
If you are worried that private information 
about yourself may be available publicly, it’s 
important to report it right away so that your 
identity can be protected. If identity theft 
goes undetected, thieves can use stolen 
information for a long time, creating long-
lasting problems. 

Figure 6.1 B

Lesson 6.1Formatting Text into Columns
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Breaks:  
Use this drop-down menu to add a break at your 
current location and to have your text continue on 
the next page, section, or column.

Page Orientation:  
Use this drop-down menu to give your 
pages a portrait or landscape layout.

Lesson 6.2 

Part 6: Working with Columns and Page Setup 

Password Power
Using Column Breaks

Lesson Overview
Appropriate use of columns and page orientation can greatly enhance 
the appearance of a document. When text is formatted as columns, words 
automatically wrap to the next column when the text reaches the end of 
the current column. However, if a new column is required prior to the text 
reaching the end of the current column, then a hard column break can be 
inserted, causing the cursor to move to the top of the next column. 

In this lesson, you will add a column break and change your page orientation to 
improve the appearance of your document.

Tools & Terms
Review the following tools that you will learn and practice using in this lesson, as you may be required to take an 
assessment after completing this part.

Skills
  Modify page setup

  Insert column breaks
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1. Using Word 2016, create a new Blank document.

2. Save the file as 6.2 Password Power in your My Word Projects folder on your 
hard drive or network drive.

3. At the top of the document, key the text as shown in Figure 6.2 A. 

4. From the Layout tab, Page Setup group, do the following:

a. From the Orientation drop-down menu, select Landscape.

b. Adjust the margins to Narrow.

c. Select all of the text, except the title and subtitle, and split your text into 
three columns.

d. Place the cursor to the left of the text [Eight Tips] and from the Breaks 
drop-down menu, select Column.

5. Make the following formatting changes:

a. Center and bold the title and subtitle.

b. Change the font size of the title to 22.

c. Change the font size of the subtitle to 16 and all caps.

d. Change the font size of the text of the columns to 14.

e. Change the text of the columns to justify.

6. Proofread your document for accuracy and format, then resave the file.

7. Print preview. Your document should look similar to Figure 6.2 B.

8. Print or share the document if required by your instructor.

4a.

4d.

4.

Using Column Breaks Lesson 6.2

Instructions
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Password Power 

How to create a strong password 

Passwords are like locks that keep our private information safe. Email, social networks, and some 
gaming websites all use passwords to help protect our private data. Without a strong password, private 
information can be easy for thieves to steal. There are websites to help you generate strong passwords, 
such as strongpasswordgenerator.com. You should also follow some tips for creating stronger 
passwords. 

Eight Tips 

Tip #1 - Do not use any self-identifying facts. Never use your full name, birth date, or address. 

Tip #2 - Avoid using obvious facts about yourself. Never use information that would be easy to guess, 
such as your nickname or your pet’s name.  

Tip #3 - Make passwords of at least eight characters. However, follow the instructions on a website for 
password length. Some websites may require passwords longer than eight characters. 

Tip #4 - Include a combination of numbers, symbols, and letters. This will make your passwords as 
unique as possible. Some websites require this combination of characters. Websites may also tell you 
whether a password is weak or strong. If a website indicates that your password is weak, add characters 
until it is strong. Be sure to read the recommendations on a website for creating a strong password 
whenever setting up a new online account.  

Tip #5 - Change your password every few months. Put yourself on a schedule for updating and 
recreating your passwords. 

Tip #6 - Create passwords that you will remember. If you think you will have trouble remembering them, 
write them down and keep them in a safe place.  

Tip #7 - Do not enter your passwords into your phone. Someone might steal your phone, or you might 
lose it.  

Tip #8 - Do not type your passwords in a public place. People might look over your shoulder as you type 
in your passwords. Additionally, if you are in a public place that offers free Internet access, such as a 
coffee shop, people using the same wireless connection might be able to see your passwords as you 
type them into a website. 

Figure 6.2 A

Lesson 6.2 Using Column Breaks
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Figure 6.2 B

Lesson 6.2Using Column Breaks
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Header: 
Use this drop-down menu to repeat content at 
the top of each page in the document.

Footer: 
Use this drop-down menu to repeat content at 
the bottom of each page in the document.

Lesson 7.1 

Part 7: Using Headers, Footers & References 

Student Council 
Letterhead
Using Headers and Footers

Lesson Overview
Creating headers and footers allows you to repeat text and graphics on each page without interfering with the 
body of the document. Headers and footers typically appear above and below the page margins. Text can be 
formatted the same way that it can be formatted in the body of the document. Predefined tabs are set in the 
header to align text to the left, center, and right. Most often, headers contain page numbers, dates, or file names. 
However, a great way to utilize headers and footers is by creating a letterhead. Businesses and organizations use 
letterhead that often include the establishment’s name, address, website, contact information, and logo. The file 
then acts as a stationery template for all business correspondence. 

In this lesson, you will use a header and footer to create a letterhead for a school’s student council.

Tools & Terms
Review the following tools that you will learn and practice using in this lesson, as you may be required to take an 
assessment after completing this part.

Skills
  Insert headers and 
footers
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1. Using Word 2016, create a new Blank document.

2. Save the file as 7.1 Student Council Letterhead in your My Word Projects folder 
on your hard drive or network drive.

 Note: Throughout this lesson, use Figure 7.1 A as a guide.

3. Change the margins as follows: top margin 2”, bottom, left, and right margins 1”.

4. From the Insert tab, Header & Footer group, Header drop-down menu, do the 
following: 

a. Insert a Header and select Blank in the Built-in section.

b. Key the text [Canyon View High School Student Council] on line 1 of the 
Header.

c. Key the text [Home of the Lions] on line 2 of the Header.

d. Key the text [President – Sam Henry] on line 3 of the Header.

e. Hit the Tab key two times and key the text [Vice President – Matt Curry] 
on line 3 of the Header so that the text is right aligned.

f. Key the text [Treasurer – Sabrina Harris] on line 4 of the Header.

g. Hit the Tab key two times and key the text [Secretary – Jeff Lane] on line 4 
of the Header so that the text is right aligned.

h. From the Footer drop-down menu, select Blank in the Built-in section.

i. Key the text [1250 Tallwood Avenue] on line 1 of the Footer.

j. Hit the Tab key one time and key the text [Phoenix, AZ 85021] on line 1 of 
the Footer so that the text is center aligned. 

k. Hit the Tab key one time and key the text [602-555-1212] on line 1 of the 
Footer so that the text is right aligned. 

4.

4a.

4h.

Using Headers and Footers Lesson 7.1

Instructions

193Part 7: Using Headers, Footers & References



5. Make the following formatting changes:

a. Center align line 1 of the Header, then change the font to Forte and the 
font size to 26.

b. Center align line 2 of the Header, then change the font to Verdana and the 
font size to 20.

c. Change the font of lines 3 and 4 of the Header to Verdana and the font size 
to 11.

d. Move your cursor to the end of line 4 of the Header and hit the Enter key 
once, then add a bottom border.

e. Change the font of line 1 of the Footer to Verdana.

f. Move your cursor to the beginning of line 1 of the Footer and hit the Enter 
key once.

g. Move your cursor up to the newly added blank line and add a top border.

6. Proofread your document for accuracy and format, then resave the file.

7. Print preview. Your document should look similar to Figure 7.1 B.

8. Print or share the document if required by your instructor.

Lesson 7.1 Using Headers and Footers
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Canyon View High School Student Council 
Home of the Lions 
President – Sam Henry Vice President – Matt Curry 
Treasurer – Sabrina Harris  Secretary – Jeff Lane 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
1250 Tallwood Avenue Phoenix, AZ 85021 602-555-1212 

Figure 7.1 A

Lesson 7.1Using Headers and Footers
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Canyon View High School Student Council 
Home of the Lions

President – Sam Henry Vice President – Matt Curry
Treasurer – Sabrina Harris Secretary – Jeff Lane

1250 Tallwood Avenue Phoenix, AZ 85021 602-555-1212

 

Figure 7.1 B

Lesson 7.1 Using Headers and Footers
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Signature Line: 
Use this icon to insert a signature line that specifies 
the individual who must sign the document.

Date & Time: 
Use this icon to add the current date or time 
to a document.

Page Number: 
Use this drop-down menu to insert the 
current page number, or the current 
page number and the number of pages 
in your document.

Page Break: 
Use this icon to add a page or section break 
at the current location.

Lesson 7.2

Tools & Terms
Review the following tools that you will learn and practice using in this lesson, as you may be required to take an 
assessment after completing this part.

Skills
� Insert a date

  Insert page numbers

  Insert page breaks 

� Insert a signature line

Part 7: Using Headers, Footers & References 

Classroom Rules
Formatting Headers and Footers

Lesson Overview
A document has much more information connected to it than what you 
see on your screen. Word processing files have page numbers, file names, 
word counts, and an author, which can be made visible to your reader. This 
information can be inserted to appear anywhere on the page, but it is most 
typically done in the header or footer. Page numbers will update as you edit 
your document and fields such as the current date and time can easily be 
added onto the page. You can also insert pre-formatted text features, such 
as a signature line indicating who needs to sign a document. Page breaks 
can also be inserted anywhere in your document to mark the place where 
one page ends and another begins. 

In this lesson, you will create a Classroom Rules Contract for students to sign.
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1. Using Word 2016, create a new Blank document.

2. Save the file as 7.2 Classroom Rules in your My Word Projects folder on your 
hard drive or network drive.

3. From the Insert tab, Header & Footer group, do the following: 

a. Insert a Header and select Blank in the Built-in section.

b. Key the text [Student Contract] left aligned on line 1 of the Header.

4. From the Header & Footer Tools, Design tab, Insert group, do the following:

a. Place your cursor after the text [Student Contract] in the 
Header and hit the Tab key two times, then click Date & Time.

b. From the Date & Time dialog box, insert the Date using the third option 
listed.

c. Click OK.

5. From the Header & Footer Tools, Design tab, Header & Footer group, Page 
Number drop-down menu, do the following:

a. Insert a Page Number, Bottom of Page, Bold Numbers 3 in the Footer.

6. Close the Header and Footer (as shown below):

7. Change the line spacing to single with no additional space before or after 
paragraphs.

8. Key the text as shown in Figure 7.2 A. 

4b.

5a.

4.5.

Formatting Headers and FootersLesson 7.2

Instructions
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9. From the Insert tab, Pages group, do the following:

a. Place your cursor at the beginning of the Confirmation of Class  
Rules section and insert a Page Break.

 Note: You are now on page two of the document.

10. From the Insert tab, Text group, do the following:

a. Place your cursor between the Confirmation of Class Rules section and the 
No Cheat Policy section, then from the Signature Line drop-down menu, 
select Microsoft Office Signature Line....

b. From the Signature Setup dialog box, key [Your Name] for the Suggested 
signer and [Student] for the Suggested signer’s title, then click OK as 
shown in Figure 7.2 B, Page 2. 

c. Place your cursor at the end of the No Cheat Policy section and hit the 
Enter key.

d. Insert a Signature Line below the No Cheat Policy section and key the 
Signature Line text as shown in Figure 7.2 B, Page 2.

11. Make the following formatting changes:

a. Apply Bullets to the INSTRUCTIONS section.

b. Center align the text [Class Rules] and change the font size to 24. 

c. Apply Numbering to the Class Rules section.

d. Italicize the Confirmation of Class Rules section, including the title. 

e. Underline the No Cheat Policy section, including the title.

12. Proofread your document for accuracy and format, then resave the file.

13. Print preview. Your document should look similar to Figure 7.2 B, Pages 1 and 2.

14. Print or share the document if required by your instructor.

10.9.

10a.

10b.

Lesson 7.2Formatting Headers and Footers
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INSTRUCTIONS 
Please read the classroom rules shown below. 
Sign your name on the line confirming your understanding of the rules and your commitment to follow 
them. 
Sign your name on the line confirming your understanding of the No Cheat Policy. 
 
Class Rules 
Respect yourself, your peers, your teacher, and the school. 
Be on time. Detention will be assigned if you are late for class without an approved excuse. 
Food or drinks are not allowed in the classroom. 
Use the lavatory before coming to class. 
You must have your planner to leave the room. 
Work for the entire class period. Your instructor will tell you when to stop. Failure to comply with this 
rule will negatively impact your participation grade. 
Leave your desk in proper order: close and store your laptop, recycle papers, push in your chair. If you 
leave your desk and it was not cleaned, then next class you will have to stay. 
Stay in your seat until the bell rings. 
Computer games are not allowed during class. If this rule is broken, you will lose your computer 
privileges for the day and any assignments for that day will receive a grade of 0. 
Use of the Internet, including email, is allowed only for classwork or with permission from your teacher. 
No proxies are to be used to circumvent the school’s firewall. If this rule is broken, you will lose your 
computer privileges for the day and any assignments for that day will receive a grade of 0. Also, refer to 
the student handbook on use of the Internet. 
Participate positively in class with the goal of enhancing the learning experience for yourself and your 
peers. 
 
Confirmation of Class Rules 
I understand that I am responsible for my computer and work area. If I don’t report any 
problems/vandalism at the start of class, I will be held responsible. It will be assumed that the problem 
happened during my class hour. Any act of vandalism results in the loss of computer privileges for the 
school year.  
 
No Cheat Policy 
I understand that if I submit any work that is not my own, I will receive a grade of 0 for that assignment. 
The person who has allowed the copying will also receive a grade of 0. The second offense will result in 
my removal from the class and loss of any credit earned. 

Figure 7.2 A

Lesson 7.2 Formatting Headers and Footers
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Student Contract  Current Date 

Page 1 of 2 
 

INSTRUCTIONS 
• Please read the classroom rules shown below. 
• Sign your name on the line confirming your understanding of the rules and your commitment to 

follow them. 
• Sign your name on the line confirming your understanding of the No Cheat Policy. 

 

Class Rules 
1. Respect yourself, your peers, your teacher, and the school. 
2. Be on time. Detention will be assigned if you are late for class without an approved excuse. 
3. Food or drinks are not allowed in the classroom. 
4. Use the lavatory before coming to class. 
5. You must have your planner to leave the room. 
6. Work for the entire class period. Your instructor will tell you when to stop. Failure to comply 

with this rule will negatively impact your participation grade. 
7. Leave your desk in proper order: close and store your laptop, recycle papers, push in your chair. 

If you leave your desk and it was not cleaned, then next class you will have to stay. 
8. Stay in your seat until the bell rings. 
9. Computer games are not allowed during class. If this rule is broken, you will lose your computer 

privileges for the day and any assignments for that day will receive a grade of 0. 
10. Use of the Internet, including email, is allowed only for classwork or with permission from your 

teacher. No proxies are to be used to circumvent the school’s firewall. If this rule is broken, you 
will lose your computer privileges for the day and any assignments for that day will receive a 
grade of 0. Also, refer to the student handbook on use of the Internet. 

11. Participate positively in class with the goal of enhancing the learning experience for yourself and 
your peers. 

  

Figure 7.2 B, Page 1

Lesson 7.2Formatting Headers and Footers
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Student Contract  Current Date 

Page 2 of 2 
 

 
Confirmation of Class Rules 
I understand that I am responsible for my computer and work area. If I don’t report any 
problems/vandalism at the start of class, I will be held responsible. It will be assumed that the problem 
happened during my class hour. Any act of vandalism results in the loss of computer privileges for the 
school year.  

X
Your Name
Student

 
 
No Cheat Policy 
I understand that if I submit any work that is not my own, I will receive a grade of 0 for that assignment. 
The person who has allowed the copying will also receive a grade of 0. The second offense will result in 
my removal from the class and loss of any credit earned. 

X
Your Name
Student

 

Figure 7.2 B, Page 2

Lesson 7.2 Formatting Headers and Footers
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Part 8
Working with 
Graphics and 
Visual Elements

8.1 High School Musical Auditions Flyer
Inserting and Working with Pictures

8.2 Letterhead with Picture
Formatting Picture Styles

8.3 Start Saving
Combining Pictures with Text

8.4 Life Cycle of a Butterfly
Using Shapes

8.5 Visual Resume
Working with Graphic Elements

8.6 YouTube Superstars
Inserting an Online Video

8.7 Just Google It
Inserting a Screenshot

8.8 Slater Farms
Enhancing Pictures

8.9 Slater Farms 2
Working with Accessibility and Compatibility Issues

Part 8 Assessments
Performance and Written Assessments are located with the Instructor 
Resources.
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Online Pictures: 
Use this icon to find and insert pictures 
from a variety of online sources.

Resizing: Use the handles that surround the 
picture to size appropriately.

2.

Layout Options: Use this icon to select how 
your object interacts with the text around it. 

3.

1.

2.

3.

Rotating: Use the rotate tool to turn your 
picture appropriately.

1.

Moving: Use the four-arrowed cursor to move 
your object.

4.

4.

Lesson 8.1 

Tools & Terms
Review the following tools that you will learn and practice using in this lesson, as you may be required to take an 
assessment after completing this part.

Skills
  Insert pictures

  Wrap text around 
objects

  Format objects

  Position objects 

Part 8: Working with Graphics and Visual Elements 

High School Musical 
Auditions Flyer
Inserting and Working with Pictures

Lesson Overview
Pictures add a visual element to your document that can draw attention 
to your message. Working with pictures and graphics requires the ability 
to resize and lay out the object in an attractive manner. Consider your 
document a piece of visual communication and design the page with that 
in mind. The placement of the graphic is important, so try using an effective 
layout technique. For example, placing your graphics on the page in a 
symmetrical way is aesthetically pleasing to viewers. 

In this lesson, you will create a flyer that includes text and graphics.
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1. Using Word 2016, create a new Blank document.

2. Save the file as 8.1 High School Musical Auditions Flyer in your My Word 
Projects folder on your hard drive or network drive.

3. At the top of the document, key the text as shown in Figure 8.1 A.

4. Make the following formatting changes: 

a. Apply a 6 pt, Blue, Box page border.

b. Center align all text.

c. Insert seven (approximately) blank lines between the first and second 
lines of text.

d. Change the font of the first line to Broadway, the font size to 48, and the 
font color to Blue.

e. Change the font of the last line to Broadway, the font size to 28, and the 
font color to Blue.

f. Bold the remaining lines, then change the font to Garamond and the font 
size to 24.

5. From the Insert tab, Illustrations group, do the following:

a. Click Online Pictures.

b. Insert two musical-themed images by keying the text [musical] in the Bing 
Image Search field.

 Note: Images may vary. Use your best judgment when selecting an image.

c. So that you can freely move your images near each other on the same 
line, select each image and select the Through layout option from the 
Layout Options icon that appears above the images.

d. Resize the images using the handles in the corner of the image.

 Note: Resize the images similarly to the images shown in Figure 8.1 B.

e. Move the images on the page as shown in Figure 8.1 B.

f. Using the Rotate tool, rotate the two images so that they are  
slightly angled as shown in Figure 8.1 B.

6. Proofread your document for accuracy and format, then resave the file.

7. Print preview. Your document should look similar to Figure 8.1 B.

8. Print or share the document if required by your instructor.

5c.

5b.

5.

Inserting and Working with Pictures Lesson 8.1

Instructions
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Broadway Musical Review Auditions 

February 25, 20xx 

High School Auditorium 

4:00 pm – 8:00 pm 

Be prepared to dance, sing, and read a monologue 

Figure 8.1 A

Lesson 8.1 Inserting and Working with Pictures
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Broadway 
Musical Review 

Auditions 
 

 

 

 

 

 

 

February 25, 20xx 
High School Auditorium 

4:00 pm – 8:00 pm 

Be prepared to dance, sing, 
and read a monologue 

Figure 8.1 B

Lesson 8.1Inserting and Working with Pictures
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Part 9

9.1 Excellence in Photography
Creating an Award Certificate

9.2 Internship Newsletter
Creating a Newsletter

9.3 What’s New in 2016
Creating a Blog Post

Part 9 Assessment
Performance Assessment is located with the Instructor Resources.

Using 
 Templates
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Templates: 
Use this feature to find documents where the formatting is already complete and you can populate the text fields.

Lesson 9.1 

Tools & Terms
Review the following tool that you will learn and practice using in this lesson, as you may be required to take an 
assessment after completing this part.

Skills
  Create a blank 
document using a 
template - Certificate

Part 9: Using Templates 

Excellence in 
Photography
Creating an Award Certificate

Lesson Overview
Designing attractive documents takes creative talent. Page layout, colors, 
and images all contribute to a page that is easy to read, conveys the right 
tone, and communicates your message clearly. Whether you are trying to 
create an award certificate or a flyer, using a template can save you time 
and assist you in generating the perfect piece of visual communication. 
Microsoft Word 2016 is equipped with thousands of pre-designed 
templates that are readily available for your use. They can be customized by 
personalizing the text fields.

In this lesson, you will use a template to create an award certificate for this year’s 
best photography student.
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1. Using Word 2016, from the Start screen, search for a [World’s Best Award 
Certificate] in the Search for online templates field.

 Note: If Word is open already, you can access the Search for online templates 
field by selecting New in the Backstage View.

2. Select the World’s Best award certificate and click the Create icon (as shown 
below):

3. Save the file as 9.1 Excellence in Photography in your My Word Projects folder 
on your hard drive or network drive.

4. Make the following text and formatting changes: 

a. Select the whole document and adjust the margins to Normal, and the left 
and right indent to 0”.

b. Key the text [AMATEUR] in place of [WORLD’S BEST].

c. Key the text [PHOTO CONTEST] in place of [NAME/TITLE].

d. Key the text [Your Name] in the [Recipient name here] section.

e. Key the text [Excellence in Black & White Photography] in the [Your text 
here] section.

5. Proofread your document for accuracy and format, then resave the file.

6. Print preview. Your document should look similar to Figure 9.1.

7. Print or share the document if required by your instructor.

1.

Creating an Award Certificate Lesson 9.1

Instructions
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Figure 9.1

Lesson 9.1 Creating an Award Certificate
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Part 10
Sharing and 
Working  
Collaboratively

10.1 Step By Step
Managing Shared Files

10.2 Feedback 101
Managing Revisions

10.3 Who Am I
Using Comments While Collaborating

10.4 Finding a Career
Reinforcement Activity

Part 10 Assessments
Performance and Written Assessments are located with the Instructor 
Resources.
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Can edit/Can view: 
Use this drop-down menu to assign 
permission for the shared user to edit 
or view your document. 

Shared by me: 
Use this folder to view, open, and 
manage the files that you have shared 
with other users.

Shared: 
Use this folder to view, open, and 
manage the files that have been shared 
with you by other users.

Move to: 
Use this option to move a file that has 
been shared by you to another location 
on your OneDrive.

Copy to: 
Use this option to copy a file that 
has been shared with you to another 
location on your OneDrive. You will no 
longer see changes made by the owner 
or other users in your copied file.

Share: 
Use this icon to share a document 
with another user. 

Invite people: 
Use this feature to enter the email address of another 
user that you wish to share your document with. You can 
also search your address book for contacts.

Lesson 10.1 

Tools & Terms
Review the following tools that you will learn and practice using in this lesson, as you may be required to take an 
assessment after completing this part.

Skills
� Share a document 

� Assign collaboration 
permission

� Copy and move shared 
files

Part 10: Sharing and Working Collaboratively 

Step By Step
Managing Shared Files

Lesson Overview
OneDrive.com is a cloud storage service which allows you to store your files 
and access them from any computer or device with an Internet connection. 
Microsoft Word 2016 allows you to create, share, and collaborate with others 
while using the software’s features and functions. Shared files must be saved 
to your OneDrive and can be managed at OneDrive.com once they are 
shared. Files that you share can be moved to other folders on your OneDrive, 
making it easy for you to find them later. Files that have been shared with 
you can only be copied to other folders. If copied, any changes that the 
owner or other users make will not appear in the copied version. 

In this lesson, you will manage shared documents in your OneDrive.
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1. To complete this lesson, you must be assigned a partner with whom you will 
share your document.

 Note: Some steps/screenshots may differ from those presented below, 
depending on the version of Microsoft Word you are using.

2. Using Word 2016, create a new Blank document.

3. At the top of the document, key the text as shown in Figure 10.1.

4. Proofread your document for accuracy and format.

5. To Share the document with your partner who will, in turn, share their 
document with you, do the following:

a. Save the file as 10.1 Step By Step-Your Name in your My Online Word 
Projects folder on your OneDrive. 

b. Click the Share icon.

c. Enter the student’s email address in the Invite people field and assign Can 
view permission, then click Share (as shown below):

6. Go to OneDrive.com and sign into your OneDrive account.

5.

Managing Shared Files Lesson 10.1

Instructions
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7. Locate the file you shared with your partner by doing the following:

a. Select Shared to see a list or thumbnail view of all the files that you have 
shared and that have been shared with you (as shown below):

b. In the Shared by me section, right click the file 10.1 Step By Step-Your 
Name and select Move to.

c. From the Move pane, select the Documents folder, then click the Move 
button.

8. In the Shared section, locate the file shared with you by your partner by doing 
the following:

a. Select Shared to see all the files that you have shared and that have been 
shared with you.

b. Right click the 10.1 Step By Step-Your Partner’s Name and select Copy to.

c. From the Copy pane, select the My Online Word Projects folder, then 
click the Copy button.

9. Print or share the document if required by your instructor.

7b.

7c.

8b.

8c.

Lesson 10.1 Managing Shared Files
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How to Make a Sandwich 

Step 1 Lay out two slices of bread 

Step 2 Open a jar of peanut butter 

Step 3 Open a jar of jelly 

Step 4 Use a spreader to spread a thin layer of peanut butter on one side of each slice of bread 

Step 5 Wipe the spreader clean using a clean paper towel 

Step 6 Use the spreader to spread a thin layer of jelly on top of the peanut butter on each slice of bread 

Step 7 Stack one piece of bread, jelly side down, on top of the other piece of bread, so that the jelly 
sides touch 

Step 8 Cut the sandwich in half on a diagonal with a sharp serrated knife 

Step 9 Serve to someone who will enjoy eating the sandwich 

Figure 10.1

Lesson 10.1Managing Shared Files
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